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Before we begin:
Download crucial Depthmap resources for the advanced user:

1. Topomet plug-in (usage described later in this presentation)
2. The Scripting manual
3. Join the Mailbase



Crucial Depthmap resources for the advanced user
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1. Topomet plug-in (usage described later in this presentation)
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1. Topomet plug-in (usage described later in this presentation)
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. Topomet plug-in (usage described later in this presentation)

Save in the same folder as the Depthmap application

21|
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File name: topomnet 32 dll - Save

Save az lype:

In order for DLLs to work, you must not change the name of the
Depthmap program



To check installation, restart Depthmap and look at the tools menu
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There should be an extra menu item called “Extra Segment Tools”



2. The Scripting manual
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2. The Scripting manual
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2. The Scripting manual
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2. The Scripting manual

Jsalascript.pdf (application,/pdf Object) - Mozilla Firefox
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Chapter 1

Introduction

SalaSeript is part of the TCL Depthmap scfiware package to perform spatial
network analysis. UCL Depthmap primarily crestes and snalysas networks ac-
cording to space syntax techniques, but it is able to analyse any network which
hagz spatial representation of nodes. SalaSeript further allows the user to medify
measures calonlated by TCL Depthmap, and to parform their own analysis of
graphs within TCL Depthmap.

At its meost basic, SalaSeript allows manipulaticn of measures caloulated
by UCL Depthmap, or the selection of nodas according to values assignad by
UCL Depthmap. For exsmpls, rather than esnnectivity!, you may want to
lock at connestivity squared, or you may want to salact all the nodes whers the
connectivity is greater than 3. For column replacement, SalaScript is invoked
when you adit an attribute in UCL Depthmap, for exampls, right-clicking on the
atiribute in the sidebar and choosing “Edit..." from the popup menn, or choosing
‘Edit...” from the ‘Attributas’ menn. For querying, SalaScript is invoked from
the ‘Edit" menu, and choosing “Balect by CQuery’. You are presentad with a box
to enter your formula and a list of existing atiribute columns for the map.

If replacement of attribute values or sslection by quary is the sort of usags
you have in mind, then you can dive straight into Chapter 2 now. For the vast
majority of users this will be their only mode of encounter with SalaSeript.
However, more advanosd users may wish to caloulate their own measures of the
graph. In SalaScript version 1.0, thoss measures are restricted to ‘per nods’
caloulations, So you are given a clean sheet for each node, and your script is
run for it. If this is your sort of usage, then you will probably be able to guess

'In space syntax tarms, the connestiity of & neds is the mumbar of adjacent nedos.
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3. Join the Mailbase
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3. Join the Mailbase
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3. Join the Mailbase
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Segment Analysis



Segment analysis varieties: Analysis Type

Analysis in Depthmap examines the shortest path between one node
and a series of other nodes in the system

'‘Shortest path' can be defined in a number of ways:

Angular = the shortest path is the one that minimises the angle between
you and your destination

Segment = the shortest path is the one that uses the least number of
streets (actually the least number of “interjunction” stretches of street) to get
to your destination

Topological = the shortest path is the one that uses the fewest number of
turns (note that topological is the analysis as axial, but with a finer
resolution)

Metric = the shortest path is the one that is physically shortest



Segment analysis varieties: Radius

Analysis in Depthmap examines the shortest path between one node
and a series of other nodes in the system

In addition to the analysis type, the selection of “other nodes” in the system

can be governed by radius, which we might think of as a “cookie cut” of a set
of nodes.

The radius might be “all nodes within 100m from the current node”, or “all
nodes within 5 turns of the current location”.

Note that the radius, like the analysis type, can be angular, segmental,
topological or metric.

For example, we might want to look at the shortest angular path to all nodes
within 100m of the node being analysed.



Segment Analysis Varieties

In fact, a matrix can be drawn of analysis types and radius types.

Analysis type

Angular Segment | Topological Metric

Angular O

Radius type Segment O

Topological

Metric O

O Depthmap analyses these combinations

This diagram is based on an original by Hoon-Tae Park



Segment Analysis Varieties

Analysis type

Angular Segment | Topological Metric

Angular O

Radius type Segment O

Topological

Metric O . .

O Depthmap ‘ The TopoMet tool analyses these combinations

This diagram is based on an original by Hoon-Tae Park



Segment Analysis Varieties: Radius in more detail

Radius might be thought of as a “cookie cutter” for the system to be analysed around a
particular node.

Angular radius examples:

Note the “cookie cut” section (in red) to be analysed depends on the node under
consideration.




Segment Analysis Varieties: Radius in more detail

Topological radius




Segment Analysis Varieties: Radius in more detail
Note that although it does not initially look like it, angular and topological radius are
(roughly) proportional to each other

We can demonstrate this with scatter plots of angular step depth versus
topological step depth

(Two scatter plots are shown: one for each of the nodes shown in the previous example)



Segment Analysis Varieties: Radius in more detail

Metric radius is quite different, and corresponds to an approximately circular
cookie cut around the node under consideration




Segment Analysis Varieties: Radius in more detail

Just as angular and topological depths are proportional to each other,
metric and segment depths are proportional to each other

(Unfortunately, there is no segmental analysis in Depthmap, so we
cannot demonstrate this directly)

There are therefore some important things we can say:

« Using angular or topological radius will give similar results
» Angular and topological analysis approximate each other (especially at high radius)

» Using metric or segment radius will give similar results
» Metric and segment analysis approximate each other (especially at high radius)



Segment Analysis over Axial Analysis

If the previous slide is correct, then surely segmental angular analysis,
because it approximates topological analysis,
should have no advantage over axial analysis?

In fact this is not true, as the segmental analysis is more distinguishing
than axial analysis.

In addition, the relationship between topological and angular analysis
may only hold for more grid like systems.



Segment Analysis Varieties: Reminder

In terms of the possible analysis combinations, Depthmap is quite
restricted. Segmen, by Shinichi lida covers all combinations

Analysis type
Angular Segment | Topological Metric
Angular O
Radius type Segment O

Topological

Metric O

O Depthmap ‘ The TopoMet tool analyses these combinations

This diagram is based on an original by Hoon-Tae Park



Segment Analysis Varieties: Reminder

Most research to date has been into just two types:
Angular with metric radius, and metric with metric radius

Analysis type

Angular Segment | Topological Metric

Angular O

Radius type Segment O

Topological

Metric O O O

The rest of this presentation will cover these in more detail

This diagram is based on an original by Hoon-Tae Park



Angular Segment Analysis

Angular Integration



Angular segment analysis

There are two main types of analysis:

* Integration, which is thought to be related to “to movement”
« Choice, which is thought to be related to “through movement”



Angular segment analysis: Integration

Unlike axial integration, there is no “approved” normalisation,
and therefore no integration measure in segment analysis

Some debate exists over what it should be:

It is known, however, that MD is an inappropriate measure,
as pointed out by N S C Dalton

Hillier has suggested
Integ = NC / MD
Where NC is node count (i.e., the number of nodes

within a “cookie cut” radius), and MD is mean depth of
the nodes with respect to the root node.



Angular segment analysis: The problem with MD

Firstly let us show the problem with MD. Let us prepare the measures we need...
Starting with an axial map, convert to a segment map:
1) Choose “Convert displayed” layer from the “Layer” menu

2) Change the default type to convert to from “Drawing layer” to “Segment map”
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Angular segment analysis: The problem with MD

3) Not necessary, but it will improve processing times and produce a tidier map:
select remove “axial stubs”, which chops off the end of lines which are not part of the network.

At first, leave the default setting: any overhang of less than 25% of the length of the line will be
removed

4) Click “OK”
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Angular segment analysis: The problem with MD

5) Select “Segment Analysis...” from the main segment tools menu
(Note my version has the TopoMet DLL installed from earlier)

6) Now | have selected a set of standard settings from the Segment Analysis Options dialog:
a) Leave the analysis type as “Tulip”, and the number of bins as “1024”

b) Include betweenness

c) Choose metric radius

d) Included a list of radii: 250,500,2000,n

(This map is in metres, so these represent 250m, 500m, 2000m, and the whole map)




Angular segment analysis: The problem with MD

At first there seems little wrong: the default is mean depth at radius n, and, playing with the

colour scheme somewhat we can get an “integration-like” measure.

Choose “Colour Range” from the “Window” menu, reverse the sliders, and tweak:
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Angular segment analysis: The problem with MD

However, if you switch to “T1024 Mean Depth r500 metric” (that is, angular mean depth
with a metric radius), no amount of tweaking gives a proper feeling of “integrated” roads.
True, a housing estate comes out blue, but the rest is pretty meaningless.
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Angular segment analysis: The problem with MD

The reason for this effect, pointed out by N S C Dalton, is that we are hoping MD tells
us something about “centrality”: how “deep” or “shallow” the node is with respect to the
rest of the graph. The problem is, at low radius, both TD and NC show this, and MD,
which is simply TD / NC, therefore cancels itself out. It may show something interesting:
that housing estate is not just an artefact, but perhaps not what we initially thought.
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Angular segment analysis: The problem with MD

At radius n there is no problem: as NC is constant (every node can see the whole system),
MD is simply proportional to TD, a measure of centrality.
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Angular segment analysis: The integration solution

Hillier's integration measure gives a solution that works both at low radius and radius n
Integ = (NC *NC)/TD
At radius n, NC is constant, so Integ for each node could as well be written 1 / TD

At low radius, NC / TD is (roughly) constant, so the second NC takes effect: Integ could
as well be written NC



Angular segment analysis: The integration solution

Let us demonstrate how integration works graphically, by creating new
integration columns for radius 500m and radius n

Remember the formula is NC / MD;

1) Create a new column (the “Add column” button)
2) Edit the new column (right click on it or press the “Update column” button)
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Angular segment analysis: The integration solution

3) Type the formula:

value (" T1024 Node Count”) / value(“"T1024 Mean Depth”)

(This can be speeded up by double clicking on the column names in the

chooser to the right of the formula box)

4) Rename the column by right click on the column name and selecting
“rename”. | will call the column “Angular Integration”
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Angular segment analysis: The integration solution

Angular integration, radius n




Angular segment analysis: The integration solution

We can verify that this is equivalent to 1/TD by creating a 1/TD column.

Follow the steps once again (add column, edit, rename) this time with the
formulal.0 / value(“"T1024 Total Depth”)
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Angular segment analysis: The integration solution

Now plot a scatter of “1 / TD” versus “Integration”
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Angular segment analysis: The integration solution

To verify that at low radius integration is proportional simply to NC, also
create a local integration column. The formula for this is:

value ("T1024 Node Count R500 metric”) /
value ("T1024 Mean Depth R500 metric”)

Compare this column simply to the
existing

“T1024 Node Count R500 metric”
in the scatter plot
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